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Handling Instructions

Ensure the following instructions are carried out by
TWO people

1. Carefully open box

2. Slide top piece of polystyrene off the screen

3. Have one person hold the screen whilst the
second person slides the bottom of the box
down
NOTE - DO NOT lift the display by the
acrylic edges. The acrylic is fragile
and may break if you attempt to lift by
the acrylic.

4. Carefully slide the bottom piece of
polystyrene from the screen

5. Lay the screen on a smooth, clean surface
ensuring the rear metal enclosure is facing
down.
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Safety Instructions

e DO NOT lift the display by the acrylic edges. The acrylic is fragile
and may break if you attempt to lift by the acrylic. It is important
that the display is lifted from the rear metal enclosure.

e Please keep the display away from any heat sources. Place the
display in a stable and well-ventilated place.

e Please handle with care as acrylic is fragile

e The holes or openings on the display are designed for ventilation.
Do not cover or block the ventilation holes or openings with any
objects.

e Remove protective covering from the screen before you use the
display.

e Shut off the power supply before cleaning. Use a soft lint-free
cloth instead of a tissue to wipe the screen.

e You may use a glass cleaner to clean the product as required.
However, never spray the cleaner directly onto the display surface.

e Do not attempt to repair this product yourself! Any modification
to the product or repair carried out that is not done with our
authorization may invalidate the warranty and could be potentially
dangerous.

e If you have a problem that cannot be solved using the
"Troubleshooting" guidelines, please contact your supplier.



TOPAZ™ 23” POS - User Manual

Quick Start Guide

This section of the guide is to allow rapid set up and use of the unit. Please refer to the main
part of the User Guide for full information on use of the unit.

Please follow the steps detailed below:

1. Unpack unit and place in desired location

2. Take the power lead from the accessories bag, insert the lead into screen and
connect to mains outlet. The unit will power ON automatically. You will be greeted
by the start-up screen.

3. Collect the files you wish to display and make sure they are supported by the unit
(see Section 2.2)

4. On a PC copy the files you want to play onto an empty USB drive. These should be in
the root directory (without putting them into a folder). Remove USB from PC.

5. Insert USB drive into the USB port located on the on the bottom of the unit (see
Figure 1).

6. The screen should indicate that it is copying the files onto the unit. Please note that
all files currently resident in the unit will be deleted. Once completed, the screen will
display a message to remove the USB drive.

7. Remove the USB drive and the unit will play the stored files in a loop.

USB PORT
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1. Introduction

Thank you for choosing the TOPAZ™ POS range for your digital signage. Please read carefully
and follow all instructions in the manual before first use.

The product should not be exposed to liquids, dripping or splashing and no objects
filled with liquids, such as vases, should be placed on or next to the product.

For user convenience, a number of operations can be performed through the remote
control.

Attention:
1. Do not change any default setting if it is unnecessary.
2. Keep the product far away from water during installation and use.

1.1 Box Contents

1 x TOPAZ™ 23” PQOS Display

1 x Mounting Plate

1 x Security Screw

1 x Power Cable

1 x CD (User Manual and Software)
1 x Remote Control

2 x Key

1.2 Product Overview
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@ Remote Control Sensor

@ AirVent
' ® Inputs
@® PowerIn
@ Security Screw Recess
, =7

- ® Lockable Card Compartment

1 | ® 856

Figure 2 Product Overview

1.3 Remote Control
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Y
Remote instruction

Button Description

POWER Power on or off
44 previous program
22 Next program
+ (volume) Raise volume
- (volume) Lower volume
PLAY/PAUSE Play/Pause,Confirm selection
f Up,navigation button
— Left,navigation button
v Down,navigation button
<« Right,navigation button
STOP Stop the selected file
SETUP Menu setting

1.4 Remote Control Sensor Location

Please see the images below on where to position the remote control in relation to

the screen
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I TR T

Fig 1.Front View — With the screen inputs at the bottom, Fig 2. Side View — Position the remote control directly
the Sensor is located at the bottom-left corner (circled). underneath the screen (so that the remote control is
Position remote as above, pointing at the screen pointing under the acrylic)

underneath the acrylic (as shown in Fig 2.).

T T

Fig 3.Do not point the remote control in front of the acrylic

1.5 Replacing the Remote Control Battery

1. Open the battery cover

2. Take out the battery box in the right direction as shown in the picture below

11
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3. Remove the used battery

4. Insert the new battery with its terminals corresponding to the indicator

5. Putthe cover backin

V.
f
9
!
9

1.6 Menu Operation

Main Menu includes the following sub-menus: Input Source, System, Display, Clock
Setup, ON/OFF Time Setup and Volume Setup.

12
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Press “SETUP” to enter Main Menu, press 1]to select the right item, press “PLAY” to
confirm selection. Choose EXIT to exit the Main Menu.

Main Menu
Input Source
System
Display
Clock Setup
ON/OFF Time Setup
Volume Setup
EXIT

Input Source:

The default input is Storage, press 1| to select another input source, press “PLAY” to
confirm selection.

Input Source
Storage
YPbPr
HDMI
AV
VGA
Return Main Menu
Input Source

System:
System
Language: ENGLISH
Show time: OFF
Clock mode: - -
Auto play system:
Seamless play OFF
Photo time 10 Seconds
Restore default:
Return

> Language: fiif&H 3¢, ENGLISH

> Clock: Turn the display clock ON/OFF, the default mode is OFF
> Clock Mode: --:--,--1--:--

> Auto Play System: Play Media, Function Mode, Time Mode

13
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Play Media: Play programs stored in CF card automatically

Auto play system

Auto Play Configuration Play Media
Play Port Time Set
1 Storage 0:00
Start Time Port End Time
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0
Return

Function Mode: programs can be played repeatedly according to pre-setup time.

Press «—— button to select item and press 1] to set up parameter.

Auto play system

Auto Play Configuration Function Mode
Play Port Time Set
1 Storage 0:00
Start Time Port End Time
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0
Return

Time Mode: It will play according to programmed schedule. There are 4 time periods

to set up.

> Seamless Play: The video file will play seamlessly if this function is turned ON.
Factory default mode is OFF

14
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Note: If this function is turned ON, the file format should be the same (including AV
resolution, frame rate and other specification), otherwise there will be intervals

between each file.

> Photo Time: Set image display time from 5 seconds to 60 seconds.

> Restore Default: Restore all parameters to factory mode

Display:
> Set screen Brightness, Contrast, Color (Saturation), Sharpness, Tint

DISPLAY
Brightness ---------- | — 50
Contrast  ---------- | E— 50
(©70] (o] SHNe——— | —— 55
Sharpness ---------- | — 50
Tint | —— 0
Aspect ratio Full
PC setting

Return main menu

> PC Setting: only applicable with VGA port

Clock: adjusts the clock

Phase: adjusts the phase

Auto Adjust: adjusts automatically according to the input signal

PC SETTING

Auto Adjust

Horizontal Pos ------------------

50

Vertical POS  ————mmmmmmmeeeee

50

Clock oo e

Horizontal Pos. / Vertical Pos.: adjusts the position of the image on the screen

15
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Clock Setup:

Press «—— button to select item and press 1| setup parameter

CLOCK SETUP
CURRENT TIME Jun/14 12:55
2012 Year Jun. Month 14 Date
12 Hour 55 Minute

Confirm
Return main menu

ON/OFF Time Setup:

It can be set to two modes: Uniform Mode, Week Mode

Uniform Mode: Set it for the whole week, for example, turn it ON at 8 am,
and turn it OFF at 10 pm.

Factory default is ON. Press ¢&-> bullon to set up ON/OFF mode and press play to confirm

selection.
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ON/OFF Time Setup

ON/OFF Mode Uniform Mode
Everyday
ON/OFF Mode Normally ON
Active ON TIME OFF TIME
Range 1 OFF 0: 00 0: 00
Range 2 OFF 0: 00 0: 00
Range 3 OFF 0: 00 0: 00

Return Main Menu

Week Mode: Set it for every day within one week, for example, set it ON/OFF mode
from Mon. to Fri., and set it to always OFF at weekend.

There are three ON/OFF mode: Normally ON, Always OFF, ON/OFF setup.

Normally ON: the player keeps turned ON once power is connected.

Normally OFF: the player will turn OFF after two minutes if there is no
operation.

ON/OFF Time Setup: 3 groups of ON/OFF setup provided in the menu.

Press «— button to set up ON/OFF mode and press “PLAY” to confirm selection.

Note: factory default is Normally ON

ON/OFF Time Setup

ON/OFF Mode Week Mode
Friday
ON/OFF Mode ON/OFF setup
Active ON TIME OFF TIME
Range 1 OFF 0: 00 0: 00
Range 2 OFF 0: 00 0: 00
Range 3 OFF 0: 00 0: 00

Return Main Menu

Volume Setup:
Press “VOLUME +” or “VOLUME —* to adjust volume or press «<—— bul]on to select.

VOLUME SETUP

17
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DEFAULT VOLUME 30
Rangel OFF
Range?2 OFF
Range3 OFF
Confirm

Return Main Menu

Press “PLAY” to set up volume of each range, press?|to select the right item.

Choose
Return to exit. See below drawing.

VOLUME SETUP

DEFAULT VOLUME
active OFF
Rangel Start Hour 00
Range?2 Start min 00
Range3 End Hour 00
End min 00
Volume 0
Confirm

Return Main Menu

2. System Operation

2.1 System Functions

18
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1. Auto Copy Function: import the media file from flash disk to memory card

automatically.

2. Auto Play System: users can set times to switch input signal from different

ports and internal storage.

3. Timer ON/OFF function.

4. Seamless Play: no black screen when program switching by following the

below requirements:

1) All of the media files should be the same format, for example it can
support suffix .TS OR .MPG video file, not both.

2) The resolution, codec, code rate, frame rate should be the same for all
video files, and the audio coder, sample rate should be the same for all

audio files.

Note: If playing high definition (HD) combine with standard definition (SD)

video file, it should:

1) Use video converter (like Ulead Video Studio) to convert the SD and
HD video files to be one HD video program.

2) Use video converter (like Ulead Video Studio) to convert the resolution,

codec and frame rate of SD file to be the same as the HD video file.

2.2 Supported Media Files

Regular play

Video Codec

Container

19
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MPEG1, 2 MPG, MPEG
MPEG2, H.264 MPEG2 -TS
H264-TS
MPEG2 MPEG2 —PS
MPEG4 AVI, MP4
Xvid 1.00
Xvid 1.01, Xvid 1.02, Xvid 1.03, Xvid 1.10-betal/2
H.264
H.264, MPEG], 2, 4 MKV
Seamless play
Video Codec Container
MPEG1, 2 MPG, MPEG
MPEG2, H.264 MPEG2 -TS
H264-TS
Audio Codec Suffix
MP3 .mp3

1. Supported video files include: MPEGZ2, H.264 file. This unit does NOT support
DIVX6.x, MSVC/CRAM, MP42, GMC, IV32, RLE, cvid, VC1, RV20 and WMV.

2. Supported audio file: MP3. This unit does NOT support Sony ATRAC3, DTS,

Dobly HD.

3. Supported image file format is JPEG. This unit does NOT support Progressive

JPEGs.

4. Support storage devices (memory card) in NTFS, FAT32 and FAT16. This

unit does NOT support NTFS compressed file.

Video and image files should be a maximum 1920x1080 resolution.(16:9 aspect

ratio)

2.3.1 Steps to Load Media Files

1. Copy the files you want to play on to USB drive in the root directory (without

putting them into a folder).

20
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N

. Insert USB drive into the USB slot (see Figure 1 and Figure 3).

3. This will automatically delete any files currently stored on the unit’s internal
memory.

4. The files will then be copied to the internal memory and once completely
loaded it will ask you to remove USB drive.

5. Remove the USB drive.

6. The unit will now play the stored files.

2.4 Inputs

CF/SD - Compact Flash and Secure Digital Card Reader
HDMI — High Definition Multimedia Interface Signal Input
VGA - Video Graphics Array Signal Input

YPbPr — Component Signal Input

Video In (AV) — Composite Signal Input

©
O
00
OO

| /
CF&SD Port /

’ Y Pb Pr

VGAIN '—==——— S OO R :

] ! | . uss
| 491 OHeN{=

Figure 3 Screen inputs

Note: The YPbPr and VGA connections cannot be used at the same time, and their
audio connection cannot be connected at the same time.

3. Installation

3.1 Wall Mounting — Landscape Orientation

21
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1. Empty contents of the box and test the screen’s power supply before
mounting.
2. Clean the wall and mark out the position of the mounting plate.

| N - | S | S | =~ | L | S | S
- -
° °
° <
- -

Figure 4 Mark out the mounting plate

3. Mark out the plates hole positions on the wall for drilling (you can drill your
own holes in the mounting plate if required).

Figure 5 Drill holes

4. Once holes are drilled into the wall insert wall plugs and fix the plate to the
wall using additional screws.

22
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Figure 6 Insert wall plugs

5. Once secured to the wall, hang the display on the bracket and connect to the
mains.

6. For an extra security measure open the Lockable Card Compartment (see
Figure 7) and secure the display to the wall bracket using the security screw
provided.

Security
screw

Figure 7 Security screw

3.2 Wall Mounting — Portrait Orientation

23
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1. Empty contents of the box and test the screen’s power supply before
mounting.
2. Clean the wall and mark out the position of the mounting plate.

I F id LA ; I [ i3 |
i []
- -
L ] L ]
] | ]

Figure 8 Mark out the mounting plate

3. Mark out the plates hole positions on the wall for drilling (you can drill your
own holes in the mounting plate if required).

Figure 9 Drill holes

4. Once holes are drilled into the wall insert wall plugs and fix the plate to the
wall using additional screws.

24
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Figure 10 Insert wall plugs

5. Once secured to the wall, hang the display to the bracket by locating the
guide holes and sliding right.

6. Connect screen to the mains using the power cable provided.

7. If you are displaying the screen in portrait orientation it is ESSENTIAL that
you secure the screen to the mounting plate. Do this by first opening the
Lockable Card Compartment (see Figure 11) and then fix the display to the
wall bracket using the security screw provided.

Security
screw

Figure 7 Security screw

25
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4. Advanced Guide

Although this unit can operate without using any additional software, for more
advanced applications please copy the scheduling software or Playlist Editor (on the
CD provided) to your computers’ hard drive.

4.1 Main Menu

On opening the application you will be greeted by the main menu screen, giving you
the options of “Create New Playlist” and “Load Existing Playlist”.

4.2 Creating Playlists
Once you have selected “Create New Playlist” the playlist creator will be launched.

&, Advertising LCD Playlist Editor

Step1: Add Schedule .+ Playlist

Step2: Add ftems

The Playlist Editor is laid out in a user friendly way with the primary functions on the
left hand side in easy to follow steps.

26
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4.2.1 Add Schedule

The schedule functions as a timer for the playlists, so you can have between one
and eight playlists scheduled to start and end at different times of the day, with up to
50 files in each playlist.

Note: If you enter more than one schedule ensure that the consecutive schedule
times do not overlap.

Click on the “Add Schedule” Button
> Type a Schedule name
> Select preferred start time
> Select preferred end time
> Click “OK”
> Schedule will appear in the playlist.

To add more schedules simply follow the whole process again for the preferred
number of schedules, ensuring you select unique schedule names and times.

4. Advertising LCD Playlist Editor =

Step1: Add Schedule ~+.* Playlist

Step2: Add ftems

4.2.2 Add Selected Items

Note: For compatible file formats please refer to 2.2 Supported Media Files.

Adding Images

Note: Before adding an image file please ensure that it has a file name of
11 characters or less and that it is NOT a progressive JPEG, as these
files will be skipped.

Click “Add Image”
> Select appropriate Schedule

27
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> Click “Browse” and locate and select files
> Enter a duration time

> Select Image switch mode

> Click “OK”

> Image appears in Schedule.

You can select multiple image files at once to add to a schedule, you can also move
each item up or down in the playlist by using the arrow buttons on the right hand

Step1: Add Schedule = Playlist
'@ Schedule Name:Schedule1 Start Time:08:00 End Time:20:00

Adding Audio

Note: Before adding an audio file please ensure that it has a file name of 11
characters or less.

Click “Add MP3”

> Select Schedule

> Click “Browse” and select MP3 file

> Enter volume level

> Click “OK”

> MP3 Appears in Schedule.

Note: You must add audio files after all image files.

(2 Ao oo =lsi)

Step1: Add Schedule =" Playlist
@ Schedule Name:Schedule1 Start Time:08:00 End Time:20:00

28
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Adding Video

Note: Before adding a video file please ensure that it has a file name of 11
characters or less.

Click “Add Video”

> Select Schedule

> Click “Browse” and locate Video file
> Enter preferred repeat

> Enter preferred volume

> Click “OK”

> Video appears in playlist.

4.2.3 Saving
Note: Before saving please ensure location drive is empty.
Click “Save to Disk”

> Click “Browse” and select the top level of the USB drive as the location of the
playlist and files

29
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4.3 Editing Playlists

From the main menu click “Load Existing Playlist”
> Locate and select playlist to edit
> Playlist appears in playlist creator

> Select item to edit and click “Edit” button located on the top right hand side of the
application.

Note: You can also add items to the playlist and add further schedules.

4.3.1 Deleting Items

To delete items within a playlist, select the item and click “Delete” - located on the
right hand side of the application. The item will be removed from the playlist.

30
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5. F.A.Qs and Troubleshooting Guide

5.1 How do | play PowerPoint presentations on my display?

5.1.1 Option 1 (for plain slides with no animation):

You can save the PowerPoint presentation as a JPEG File Interchange Format
(.JPG). Microsoft PowerPoint software allows the user to do this

1) Create or open a PowerPoint presentation.

2) Click File >Save As

3) Enter a File name

4) Click on “Save as type” scroll down and find the file extension “JPEG file
interchange format”, as shown in the image below.

Fawvorites

=]
gé File name:  [Digital Sign - Save |

My Metwark
Places Save as type: |Presentaﬁu:un - Cancel |
Design Template .
PowerPoint Show
PowerPoint Add-In J
GIF Graphics Interchange Format
JPEG File Interchange Format
PMNG Portable Network Graphics Format &7
5) Click Save.

6) A message will appear asking if you would like to save all slides as JPEG’s
7) Once you have selected your option, The JPEG images will be saved and are
ready to use within a playlist or to upload to a storage device.

Note: For the best portrait resolution, you can use this PowerPoint Page
Setup: Width 38cm;

Height 24cm (16:10 Ratio)

5.1.2 Options 2 (for presentations with animation):

You can convert the PowerPoint presentation to a MPEG video clip. For the best
display quality you should use the MPEG2 format which gives the best display
guality. We suggest that you use the following software:

Software Name: Wondershare PPT2DVD
Web link: http://www.ppt-to-dvd.com/ppt2dvd/overview.html :
Select Video Format: PowerPoint to MPEG2 Video Settings:
* TV Standard: NTSC (29.97fbs);
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« Standard: Standard DVD;
» Aspect Ratio: 16:9 (widescreen);
« Encode Size: Width 720, Height 480.

5.2 Wireless connection

The screen does not have a wireless capability built in. However, with the range of
screen inputs available as shown in Figure 3 an external network media player can
be easily connected.

5.3 Video Conversion

There are two possible tools for converting video

5.3.1 Format Factory

This is a free multipurpose convertor that can be used for normal definition

Normal Definition

1. Download a free convertor (Windows) called Format Factory which can be
found at

http://www.formatoz.com/
2. Start the Software (picture 1).

FormatFactory 2.60 T

Task Skin Language Help

— Remove 3¢ Clea

art »Q’ Option | '« | Output Folder Lﬁ/HamePage
| & =

Lis L siop QA st
| 4 5 )
) Video ‘ : F Vigbile : —
. 5 7@ e o rma t - B
Al to!M\W,‘E @ F actor \/ — .

‘a‘ Source Size Convert State Output [F2]

Allto GIF
%;
Al to WMV

o

Allto MKV o
mg? l‘b\ e
2 ;
All to MPG i & Y
. TR |\l
oIk o o
® 5
Al o VOB =

Audio ‘

Picture \

BnE

(il €

ROM Device|DVD\CDNISO |

Advanced 1

. C:\Documents and Settings\Kevin Sun\My Documents\FFOutput

3. On the left hand window pane select the ‘Video’ conversion options.
4. Select the ‘All to AVI’ conversion
5. Click the ‘Add File’ button and locate the file to be converted.
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@ E - = x

Task Skin La &7

Open

&
X
\ 4

Look inc | £ 121,32H1, 40H1.46 v © % @

0

&l17.mpa
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6. Click the ‘Output Setting’ button and modify it to look like the image shown

below. A number of important settings have been highlighted.

7. Select ‘OK’ to save these changes and then Press ‘OK’ button to goto main screen
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8. Press the ‘Start’ button along the top to start the conversion. Once completed,
press the ‘Output Folder’ to see the converted video.

e

Task Skin Language Help

e ¢ Clearlist | '€+ sto 3 Option { w2 OutputFolder HomePage
£ ® g
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|
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g
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Allto GIF

All to WMy
o 8
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ol

All to MKV

147G
©
Al to MPG
Vo: |
®
Allto VOB

Audio

Picture

ROM Device\DVD\CD\ISO

[{|G0 |~

Advanced

Za =2 Format oo i
= —y >\ — O e ) B
9 Factory ==

Source Size Convert State Output [F2]
|E|17.mpg 24.76M Allto MPG

FormatFactory 2.60 = Ex

C:\Documents and Settings\Kevin ...

_». C:\Documents and Settings\Kevin Sun\My Documents\FFOutput

5.3.2 HD Video Converter Deluxe

This is particularly useful for High Definition videos.

Download link: http://www.winxdvd.com/hd-video-converter-deluxe/

This software does require an additional purchase.

MP4 gives the best display quality. Please follow the following steps:

1.
2.

Select “to HD MP4” tab.
Change audio quality to 448 kbps, and change video quality to 12000, output
image setting to custom size with custom aspect ratio, and video resolution to
HD1080P(1920:1080), video codec to MPEGA.

See the screen shot below for the recommend settings.

!
t_ 'n !gé \WinX HD Video Converter Deue sramort

—

ing Started

ek’ @ “button to add Source video:

m “table to choose an output format:

@) “button to start conversion.

| ick Video Conversion Solution for Windows

nCoreaiVidea | a0 | iohovides | arppie | iwSiny | soiioh | sopaiabie | imbbie \
O wnoan (6 whoums | O whoupec | 0 whors ] whow | O whovor | Ownovemse]

mﬂ.h Audio Sample Rate Volue : 0 +4db  Foma:
g
2000 (2] Kbps Video FrameRate :  [Auto ~] output Format : [P+ =] video codec C[iEca]~] >

Output Image Setting : fEGs o £ Rat I;L + Hi%|HD1080P (1920:1080) i3 —
otoing g
A\ .

P T [ beinteracing 0] Use Hioh Qualty Engine ) Force A sync (enect)

34



TOPAZ™ 23” POS - User Manual

MP4 gives the best display quality. Please follow the following steps:

1. Select “to HD MP4” tab.

2. Change audio quality to 448 kbps, and change video quality to 12000, output
image setting to custom size with custom aspect ratio, and video resolution to
HD1080P(1920:1080), video codec to MPEGA4.

See the screen shot below for the recommend settings.

5.3.3 Converting a Video to play on the screen in Portrait

If your screen has been mounted in a portrait orientation and you are wishing to play
portrait videos, they will need to be rotated in order to play correctly. To do this,
follow the instructions below:

1. Download the free convertor (Windows) called Freemake Video Converter
which can be found at

Download link: http://www.freemake.com/how_to/how_to rotate video
2. Open the program and click Add a Video

f1zemake.com

‘WS.@ é{@
b o

W

Download video with Freemake

3. Browse to the video you wish to rotate and click OK.
4. The video will now be added to the converter. Click the Edit button highlighted
below
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5. The video will open in a preview screen. Click the rotate button highlighted

below.

~MPO6 o _,‘,,

6. The preview screen will now show the rotated video. Click OK.

= > > 3 0000

7. Click the Convert to AVI button.

=3 B =3
[ § | : ‘ o RS

AoOeaeadg
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8. Click Convert

N X X
24 inch Monitor O e
0:02:46 e 14 =

i H.264, MP3
lizll  Same as source

+ @

8 My Videos\24 inch Monitor.avi . n

—

@ o 0 G 6 o >

5.4 Connecting screen to PC

The simplest way is to use the VGA output from the PC or laptop and connect to the
VGA input (section 2.4) on the Display panel.

The display panel also has a HDMI and some PCs have HDMI output. In this case
connect the PC HDMI to the input HDMI on the Display panel.

5.5 My Remote Control does not appear to be working

The remote controls have been design to have a limited range as some applications
require several screens close together and individual control of each. If you are
experiencing difficulties in operating your remote please follow these steps before
calling your supplier.

1) Try pressing “SETUP” with the remote a few inches away from the unit just
below the display (see section 1.2). If this does not bring up the menu screen
then go on to step 2.

2) Replace the batteries in you Remote Control (see section 1.4). If this does not
solve the problem then please contact your supplier.

5.6 My media file does not fit properly on the screen

If your media is being displayed with black edges please refer to section 2.2. This
has happened because the file is not 16:9 aspect ratio (1920x1080). Please resize
file to 1920x1080 pixels and try loading the media onto the display once again.

5.7 My media file will not display or is missing from the playlist

In this situation the first step to take to find the root of the problem is to start with a
blank USB drive. Copy 1 file onto the blank USB drive and insert this into the unit,
ensuring that the file name is 11 characters or less. If this works and the file displays
then re-name all the files that are 12 characters or more to have shorter file names.
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If this does not work please check first that the media file is the correct size to fit the
screen —1920x1080 pixels. If it is any bigger than this there is a danger the media file
will not display.

For images, check that it is around 1-2 MB in size and that it is a baseline JPEG not
a progressive one — as these will be skipped. This can be checked by using free
software called IrfanView.

1) Download Irfanview from

http://download.cnet.com/IrfanView/3000-2192 4-10021962.htm|?part=dl-Irfa
nView&subj=dl&tag=button

2) Launch the software then open image file within the program.

dend | e Fie ~Cipen mermal

3) In the toolbar click on “Image” > “Information”.
4) This brings up the “Image property options”.
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5) Check the compression of the image, if it says “JPEG” the image is a baseline JPEG,
however if it says “JPEG, progressive” then you must convert the image using
software such as Adobe Photoshop.

5.8 My media files will not update

If you are have problems updating your display follow these steps to ensure it is not
a technical issue.

1) Ensure that there are no other files or folders stored on the USB drive.

2) Check the USB drive for any additional self installation software, if it has this
format the drive.

3) Make sure the USB drive is firmly inserted into USB slot

4) Before contacting your supplier try another USB drive to be certain this is not
the fault.

5.9 My media will not loop

If you are having issues with your content not playing over from the start once it has
come to an end, then you will have to do a system reset.

1) To do this press “SETUP” on your remote control.

2) Go to “SYSTEM” and press “PLAY”.

3) Go to “Restore Default” and press “PLAY”.

4) This will clear the unit's memory but not the time and date details, try your
media again before contacting your supplier.

For further information or technical advice please contact your supplier quoting your
model number & serial number.

6 23 inch Panel Specification

Type TET LCD

Monitor size / profile ratio 23 INCH (Digital LCD, LED Backlight) / 16:9

Display resolution

1920 x 1080

Dot pitch

0.2745 (W) x 0.2745 (H)

Display area (inches)

20 (W) x 11.3 (H)

Brightness

250 cd/m2

Contrast ratio

1000:1

Unit size (inches)

22.9 (W) x 14.1 (H) x 2 (D)

Unit Weight (Ibs) 15.2

View Angle 178°

Input Voltage AC110-240V(50Hz-60Hz)
Working Temp 0°Cto50°C

OSD menu language

English/Chinese/Japanese

Inputs

HDMI, VGA, AV, YPbr, Video In

Medium

CF Card/ SD Card/ USB

Speaker output

2Wx2
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